
Learning Objectives

Chapter 15

Complex Animation

After completing this chapter, you will be able to:
• Create dummy objects
• Create snapshot objects
• Hide objects during animations
• Animate and link cameras
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TuTorial DescripTion
In this tutorial, you will create the animation for a steel manufacturing process. You will create 
dummy objects to assist in movement during animation. You will link some objects to others 
to create a parent/child relationship. You will create snapshots of objects so that they can be 
linked to different parent objects. You will also adjust the track info of objects to hide and 
unhide them during the animation. 

Dummy objects
Dummy objects are used to control the movement of other objects by linking them, but are 
not rendered. If several objects are linked to a dummy object, the dummy can be used to move 
all objects simultaneously. The objects linked to the dummy can also to be moved individually 
without affecting the dummy object or any other object linked to the dummy object.

Before starting this tutorial, you need to download c15_maxdesign_2013_tut.zip from 
www.cadcim.com. The path of the file is as follows:

 Textbooks > Animation and Visual Effects > 3ds Max Design > Autodesk 3ds Max Design 2013: 
A Tutorial Approach

1. Select Open… from the Application Menu; the Open File dialog box is displayed. Navigate 
to the lift.max file that has been downloaded and pick the Open button.

 
The file lift.max is opened.
 
2. Select Save As… from the Application Menu; the Save File As dialog box is displayed. 

Navigate to the folder of your choice and enter Chapter15 in the File name text box. 
Then, pick the Save button to save the file.

  
The scene is saved as Chapter15.max in the folder you specified.

3. Pick the Time Configuration button in the lower-right corner of the screen.

The Time Configuration dialog box is displayed, Figure 15-1.

4. In the Animation area, enter 150 in the Length: spinner and pick the OK button.

This sets the total number of frames for the animation to 150.
 
5. Pick the Create tab in the Command Panel. Pick the Helpers button. Then, pick   

the Dummy button in the Object Type rollout.
 
6. Activate the Front viewport by clicking on it.
 
7. Pick below the Cauldron object and drag the mouse to create a small cube. Then, move 

the cube in the Left viewport to position it below the Cauldron object.

A dummy object is created, Figure 15-2.
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Figure 15-1  The Time Configuration dialog box

Figure 15-2  A dummy object created

The size of the cube does not matter. This cube is the dummy object and will not be visible in 
the rendered animation. Make the cube of a size that is easy to select, yet not so large that it 
interferes with the selection of other objects in your scene.
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8. Name the dummy object as Cal-Dummy.

9. Pick the Dummy button again. In the Front viewport, click below the Base object and 
drag the mouse to create another small cube. Adjust the position of the cube in the Left  
viewport to position it below the Base object.

 
10. Name this dummy object as Base-Dummy.
 
11. Use the Align button in the Top viewport to center the Base-Dummy object with  

the center of the Base object along the X and Y axes. Also, align the center of the 
Cal-Dummy object with the center of the Cauldron object along the X and Y 
axes.

linking objects
Linking more than one object to a dummy object simplifies the animation process and allows 
individual movement later in the animation.
 
1. Pick the Select and Link button in the Main Toolbar.    

2. Select the Cauldron object, drag the cursor to the Cal-Dummy object, and then release, 
Figure 15-3. Pick the Select Object button to end the link command.

Figure 15-3  Linking the objects 

When the first object is selected, the link cursor appears. On dragging the mouse button and 
releasing it on the second object, the two objects will be linked. The Cauldron object becomes 
a child of the Cal-Dummy object and will follow its movement.



Complex Animation       295

3. Pick the Select and Link button. Then, select the Hook object, drag the cursor to the 
Cal-Dummy object, and release the cursor. Pick the Select Object button to end the link 
command.

The Hook object becomes a child of the Cal-Dummy object and will follow its movement.
 
4. Pick the Select and Link button. Then, select the Base object, drag the cursor to 

the Base-Dummy object, and release. Pick the Select Object button to end the link 
command.

 
5. Save the scene.

setting animation Defaults
Continuity controls an object’s movement through animation keys, creating the appearance 
of life-like motion, or creating the appearance of mechanical motion. The objects in this 
animation should have mechanical motion. A continuity default value can be set before creating 
animation keys so that each key does not have to be individually adjusted later.
 
1. Select Preferences… from the Customize pull-down menu. Then, in the Preference 

Settings dialog box, pick the Animation tab.

2. In the Controller Defaults area, pick the Set Defaults… button. 
  
The Set Controller Defaults dialog box is displayed, Figure 15-4. 

Figure 15-4  The Set Controller Defaults dialog box

3. Select TCB Float from the list in the Set Controller Defaults dialog box and pick the 
Set… button. 

The TCB Default Key Values dialog box is displayed, Figure 15-5. 
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Figure 15-5  The TCB Default Key Values dialog box

4. In the TCB Default Key Values dialog box, enter 0 in the Continuity: spinner and then 
pick the OK button.

5. Pick OK in the Set Controller Defaults dialog box. Then, pick OK in the Preference 
Settings dialog box.

animating the Hook and cauldron
To create an animation, a series of keys are defined. Autodesk 3ds Max Design fills in animation 
between the keys.
 
1. Select the Toggle Auto Key Mode button to turn the animation mode on (red).   

When the Toggle Auto Key Mode button is on (red), any transformation creates an animation 
key on the current frame. If this button is off, the transformation is applied to frame 0, 
regardless of the current frame.
 
2. Drag the Time Slider to frame 25. Alternatively, you can enter the value 25 in the spinner 

at the left side of the Time Configuration button. 
 
3. Right-click on the Select and Move button. 

The Move Transform Type-In dialog box is displayed, Figure 15-6. This is a mode less dialog 
box and can remain open as you select objects.

Figure 15-6  The Move Transform Type-In dialog box 

4. Make the Front viewport active.

5. Select the Cal-Dummy object. Type 300 in the X: spinner in the Offset: Screen area of the 
Move Transform Type-In dialog box and press the ENTER key.

The Cauldron is now centered over the circular Base object.
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6. Drag the Time Slider to frame 50.

7. With the Call-Dummy object selected, enter –300 units in the Y: spinner in the Offset: 
Screen area of the Move Transform Type-In dialog box and press the ENTER key.

This places the Cauldron object on the circular Base object, Figure 15-7.

Figure 15-7  The Cauldron placed on the circular Base object

8. Close the Move Transform Type-In dialog box and exit the animation mode by picking the 
Toggle Auto Key Mode button.

9. Save the scene.

adding an animation Key to a Frame
Currently, if the movement of the Hook object was animated, the movement would begin at 
frame 0 and would end at whatever frame was current when the Hook was moved. Because 
of this, the Hook would gradually drift away from its parent object. To prevent this, the Hook 
needs a position key added at frame 50. The position key locks the Hook’s position at frame 
50. Any movement applied to the Hook affects only frames between frame 50 and the current 
frame. Track View is used to create the position key.
 
1. Select all objects in the viewport. Next, select Track View-Dope Sheet… from the 

Graph Editors pull-down menu.

The Track View-Dope Sheet is displayed. 

2. Display the tree for the Hook object. Since it is a child of the Cal-Dummy object, click on 
the plus sign (+) in a small circle next to Cal-Dummy. Then, expand the tree for the Hook 
branch and then the Transform branch.
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Track View-Dope Sheet displays the animation keys for the Hook object. Notice that currently 
there are no animation keys.

3. Pick the Add Keys button on the upper left of the Track View - Dope Sheet.                        
 
4. Click on the Position track for the Hook at frame 50.

A position key for the Hook is created on frame 50, Figure 15-8.

Figure 15-8  The new keys added to the Hook’s Position track

5. Close Track View-Dope Sheet.

6. Drag the Time Slider to frame 55 and pick the Toggle Auto Key Mode button.

7. Select the Hook object.
 
8. In the Front viewport, move the Hook object –60 units on the X axis and –60 units on the 

Y axis.

This detaches the Hook from the Cauldron.

9. Drag the Time Slider to frame 70.
 
10. Move the Hook object 300 units on the Y axis.

11. Select Saved Track Views from the Graph Editors pull-down menu. Then, pick Track 
View-Dope Sheet in the cascading menu.

The Track View-Dope Sheet is displayed with the previous settings active.

12. Pick the Add Keys button on the  upper left of the Track View-Dope Sheet.

13. Add a key in the Position track at frame 90 for the Hook. Then, close Track View-Dope 
Sheet.
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The current position of the Hook is recorded in a key on frame 90.
 
14. Drag the Time Slider to frame 105.
 
15. In the Front viewport, move the Hook object –300 units on the Y axis.
 
16. Drag the Time Slider to frame 110.
 
17. Move the Hook object 60 units on the X axis and 60 units on the Y axis.

This reattaches the Hook to the Cauldron.
 
18. Select Saved Track Views from the Graph Editors pull-down menu. Then, pick Track 

View-Dope Sheet from the cascading menu. Select the Cal-Dummy object in the viewport 
and expand the Cal-Dummy tree and the Transform branch.

19. Pick the Add Keys button and add a key in the Position track at frame 110 for the 
Cal-Dummy object. Then, close Track View-Dope Sheet.

 
20. Drag the Time Slider to frame 130.

21. In the Front viewport, move the Cal-Dummy object 300 units on the Y axis.

The Cal-Dummy, Hook, and Cauldron objects move.

22. Drag the Time Slider to frame 150.
 
23. Move the Cal-Dummy object –300 units on the X axis.
 
24. Exit the animation mode by clicking on the Toggle Auto Key Mode button. Then, drag 

the Time Slider to left and right to replay the animation. Alternatively, click on the Play 
Animation button to see the animation in the viewport.

 
25. Save the scene.

creating a snapshot
The Snapshot command duplicates an object in its current state, but unlike the Copy command, 
it does not copy any animation keys associated with the object. The snapshot copy can then be 
used for complex animation sequences. In this animation, you will be rotating the Cauldron 
by 45°. A snapshot of the Cauldron will be used to do this.

1. Drag the Time Slider to frame 50.

2. Select the Cauldron object.

3. Select Snapshot… in the Tools pull-down menu.
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The Snapshot dialog box is displayed, Figure 15-9.

Figure 15-9  The Snapshot dialog box

4. Pick the Single radio button in the Snapshot area. Also, pick the Copy radio button in 
the Clone Method area, and then pick OK.

A duplicate copy of the Cauldron object is created at the same location as the original. This 
is the reason why copy of the Cauldron had to be moved to frame 50. The copy is named as 
Cauldron001.

note
The Snapshot dialog box allows you to create multiple copies over a range of frames using 
the Range radio button or a single copy using the Single radio button.

 
5. Drag the Time Slider to frame 0.

There are now two cauldrons in the scene: the original and the copy located at the original’s 
position at frame 50 when the snapshot was made.
 
6. Pick the Select and Link button on the Main Toolbar.

7. Select the Cauldron001 object, drag the cursor to the Base Dummy object, and release. 
Pick the Select Object button to end the link command.

The Cauldron001 object is now the child of the Base Dummy object and will follow its 
movement.

8. Select Base Dummy from the viewport.
 
9. Select Saved Track Views from the Graph Editors pull-down menu. Then, pick Track 

View-Dope Sheet in the cascading menu. Expand the Base-Dummy tree and the Transform 
branch.
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10. Pick the Add Keys button and add a key in the Rotation track at frame 70 for the  
Base Dummy object. Close Track View-Dope Sheet.

11. Drag the Time Slider to frame 80. Pick the Toggle Auto Key Mode button to enter the 
animation mode. 

 
12. In the Front viewport, rotate the Base Dummy object – 45° on the Z axis.
 
13. Drag the Time Slider to frame 90.
 
14. In the Front viewport, rotate the Base Dummy object 45° on the Z axis.
 
15. Exit the animation mode by clicking on the Toggle Auto Key Mode button. Then, drag 

the Time Slider to left and right to replay the animation.

Hiding an object During animation
All parts of the animation are now complete, but there are two cauldrons visible during the 
animation. You must turn off the visibility, or hide the cauldrons during different segments of 
the animation. There are two ways to do this. You can use Track View or modify the object’s 
properties.

1. Select Saved Track Views from the Graph Editors pull-down menu. Then, pick Track 
View-Dope Sheet in the cascading menu. 

2. Select the Cauldron object in the viewport and select Cauldron in the tree so that it is 
highlighted.

 
3. Select Visibility Tracks from the Edit pull-down menu in the Track View - Dope Sheet 

and then select Add from the cascading menu.

A visibility track is added to the tree beneath Cauldron.

4. Pick the Add Keys button and add a key in the Visibility track at frame 0 for the Cauldron 
object, Figure 15-10.

Figure 15-10  Adding a new key in the Visibility track at frame 0
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5. Right-click on the new key to open the Cauldron/Visibility dialog box. Enter 1.0 in the 
Value: spinner if it is not already set to that. Also, set the In: and Out: image tiles to the 
square, mechanical transition, Figure 15-11. Leave the Cauldron/Visibility dialog box 
open.

Figure 15-11  The Cauldron/Visibility dialog box

These settings in the key make the Cauldron object fully visible at frame 0.

6. Add a key in the Visibility track at frame 50 for the Cauldron object.

7. In the Cauldron/Visibility dialog box, enter 0.0 in the Value: spinner. Also, set the In: 
and Out: image tiles to the square, mechanical transition.

This makes the Cauldron object invisible exactly at frame 50.

8. Add a key in the Visibility track at frame 90 for the Cauldron object.
 
9. Right-click on the new key to open the Cauldron/Visibility dialog box, and enter 

1.0 in the Value: spinner. Also set the In: and Out: image tiles to the square, 
mechanical transition.

This makes the Cauldron object fully visible again. Close the Cauldron/Visibility dialog 
box.
 
10. Close the Track View-Dope Sheet. Save the scene.

Hiding the object using object properties

1. Drag the Time Slider to frame 0.

2. Select the Cauldron001 object in any viewport. Right-click in the viewport and select 
Object Properties… in the lower-right quadrant of the quad menu.

The Object Properties dialog box is displayed, Figure 15-12.
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Figure 15-12  The Object Properties dialog box

3. In the Rendering Control area, first pick the By Layer button so that it  
becomes the By Object button.       

                                                                                                                                      
The options in this area become active.

4. Enter 0.0 in the Visibility: spinner. Pick the OK button to close the Object Properties 
dialog box.

The object is invisible at this frame (frame 0). This also adds a visibility track in Track View.
 
5. Drag the Time Slider to frame 50. Pick the Toggle Auto Key Mode button to enter the 

animation mode.
 
6. With the Cauldron001 object selected, right-click in the viewport and select Object 

Properties… from the quad menu. 
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7. Enter 1.0 in the Visibility: spinner of the Object Properties dialog box.

You will notice that the corners of the spinner turn red. This indicates that the parameter is 
animated.

8. Pick the OK button to close the Object Properties dialog box.

The object becomes visible at frame 50.

9. Drag the Time Slider to frame 90. With the Cauldron001 object selected, right-click in 
the viewport and select Object Properties… from the quad menu.

 
10. Enter 0.0 in the Visibility: spinner of the Object Properties dialog box. Pick the OK 

button to close the Object Properties dialog box.

This makes the object invisible at frame 90.
 
11. Exit the animation mode by pressing the Toggle AutoKey Mode button. Drag the Time 

Slider left and right to replay the animation.

Notice that the Cauldron01 object fades in and out. The transition must be adjusted in Track 
View.

12. Select Saved Track Views from the Graph Editors pull-down menu. Then, pick Track 
View-Dope Sheet in the cascading menu. Expand the tree for Cauldron001, if it is not 
already expanded.

 
13. Right-click on the first key in the visibility track. In the Cauldron001/Visibility dialog 

box, set the In: and Out: image tiles to the square, mechanical transition.

14. Repeat this for the visibility keys at frame 50 and frame 90. Close the Cauldron/Visibility 
dialog box and Track View-Dope Sheet.

 
15. Drag the Time Slider left and right to preview the animation or pick the Play Animation 

button.

Notice that the Cauldron01 object no longer fades in and out. The visibility changes for both 
cauldron objects are instantaneous, providing the illusion that there is only one cauldron in 
the scene.

16. Save the scene.

previewing the animation
Now, create a quick animation. The animation is a low resolution/low color format used to 
quickly verify that the animation is working correctly.

1. Make sure the Camera-Lift viewport is active.
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2. Select Grab Viewport from the Tools pull-down menu. Then, select Create Animated 
Sequence File from the cascading menu. The Make Preview dialog box is displayed,  
Figure 15-13.

Figure 15-13  The Make Preview dialog box

3. In the Overlay area, check the Frame Numbers check box to activate it.

4. Pick the Create button. If the Video Compression dialog box appears, pick OK to accept 
the default settings.

When the animation is completed, it is played in the Windows Media Player. Notice that the 
invisible cauldrons appear faintly. This is just a representation in the preview rendering. In 
the final animation, the cauldrons are completely invisible.

animating the camera
The camera can be animated just like any other object in the scene. When a camera is animated, 
both the camera target and camera body may need to be moved or rotated. In this scene, the 
camera has been hidden and needs to be turned back on.
 
1. Pick the Display tab in the Command Panel.         
 
2. In the Hide by Category rollout, uncheck the Cameras check box.

The camera named Camera-Lift is no longer hidden.
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3. Pick the Zoom Extents All button.

The scene is zoomed out in the viewports so that the camera and target fit on the screen.
 
4. Drag the Time Slider to frame 75.

5. Pick the Select and Move button. Next, pick the Toggle Auto Key Mode button to enter 
the animation mode.

 
6. Select the camera in the Top viewport and move it –1300 units on the X axis and 1300 

units on the Y axis (to the left and up).

7. Pick the Display tab in the Command Panel. In the Display Properties rollout, check 
the Trajectory check box.

The path that the camera follows is displayed. The dots along the path represent individual 
frames in the animation. The white boxes represent frames that have animation keys in them 
for the camera.

8. Drag the Time Slider to frame 32.

9. Select the camera in the Top or Front viewport and move it 600 units on the X axis 
and 600 units on the Y axis (to the right and up). Pick the Zoom Extents All button, 
Figure 15-14.

Figure 15-14  Adjusting the camera position in the viewport

The path bends to fit through the white box keys on the path. More keys can be added and 
moved to control the shape of the path.
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10. Exit the animation mode and save the scene.

rendering the animation for preview
Create a quick preview of the updated animation. The preview shows the effect of moving 
the camera.
 
1. Make sure the Camera-Lift viewport is current.
 
2. Select Grab Viewport from the Tools pull-down menu. Then, select Create Animated 

Sequence File from the cascading menu. The Make Preview dialog box is displayed.
 
3. Pick the Create button. If the Video Compression dialog box appears, pick the OK button 

to accept the default settings.

When the animation is completed, it is played in the Windows Media Player.

animating the camera Target
The camera target can be animated to follow the movement of an object during animation. 
A camera target can be linked as a child to the object being followed in the animation to 
simplify the process.
 
1. Drag the Time Slider to frame 0.

2. Make sure the Toggle Auto Key Mode button is off (not red).

Turning the animation mode off moves the selected object in all frames of the animation 
instead of creating an animation key at the current frame.

3. Pick the Select and Move button.
 
4. Pick the Zoom Extents All button.

5. Select the Camera-Lift.target (the camera target) object and drag it to the center of the 
Cauldron object in the Top and Left viewports, Figure 15-15.

The camera target is now centered on the Cauldron object.

6. Pick the Select and Link button on the Main toolbar.
 
7. In the Front viewport, pick the Camera-Lift.target object, drag the cursor to the Cal-Dummy 

object, and then release it. Pick the Select Object button to end the link command.

The Camera-Lift.target object is now the child of the Cal-Dummy object and will follow its 
movement.

note
If the camera represents a person walking through a scene, it is better to create a dummy object 
and link both the camera target and the person to the dummy object. In this way, only the dummy 
object will be animated.
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Figure 15-15  Adjusting the Camera-Lift.target to the center of the Cauldron object 
in the Top and Left viewports

previewing the animation
Create a quick preview of the updated animation to show the effect of moving the camera 
target.
 
1. Make sure the Camera-Lift viewport is current.

2. Select Grab Viewport from the Tools pull-down menu. Then, select Create Animated 
Sequence File from the cascading menu. The Make Preview dialog box is displayed.

 
3. Pick the Create button. If the Video Compression dialog box appears, pick the OK button 

to accept the default settings.

When the animation is completed, it is played in the Windows Media Player.
 
4. Save the scene.
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Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:
 
1. An object can be ______ to a dummy object, and it will then follow the movement of the 

dummy object.
 
2. A dummy object will not be visible on ______.
 
3. The ______ utility can be used to create a position key.

4. The ______ command duplicates an object in its current state, but does not copy any 
animation keys associated with the object.

 
5. When adjusting the key information for a key in an object’s visibility track, a setting of 

______ in the Value: spinner will make the object completely visible.
 
6. An object can be made invisible by creating a visibility track in Track View, or by 

adjusting the object’s ______.
 
7. The ______ can be animated to follow the movement of an object during animation. 
 
8. When a camera is animated, both  ______ and ______ can be moved or rotated.

9. On selecting ______ in the Display Properties rollout, camera’s path is displayed in the 
viewport.

10. Frames that have animation keys for the camera are indicated in the trajectory by 
______.

Review Questions
Answer the following questions:

1. The ________ objects are used to control the movement of other objects by linking them, 
but are not rendered.

2. The ________ button is used to link one object with another object.

3. The ________ button is used to add keys in Track View-Dope Sheet.

4. The ________ option verifies the current state of animation. 

5. The Snapshot command is similar to the Copy command. (T/F)



310          Autodesk 3ds Max Design 2013: A Tutorial Approach

Exercise

exercise 1
Using 3ds Max Design, animate the vise, Figures 15-16 through 15-19. You need to download 
the file c15_maxdesign_2013_exr.zip from www.cadcim.com. Extract the contents of the zipped 
file and open c15_exr1_start.max from it. The path of the file is as follows:

 Textbooks > Animation and Visual Effects > 3ds Max Design > Autodesk 3ds Max Design 2013: 
Tutorial Approach  

   

Figure 15-16  Animation at frame  50 Figure 15-17  Animation at frame  75

  

Figure 15-19  Animation at frame 150Figure 15-18  Animation at frame 125

answers 

The following are the answers of Self-Evaluation Test:

1. linked; 2. rendering; 3. Track View; 4. Snapshot; 5. 1.0; 6. properties; 7. camera target; 
8. camera, target; 9. Trajectory; 10. white boxes


